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The Kodak i3000 Series Scanners provide the ability to process
scanned images to improve their quality by using image processing
features. This guide provides information for the Kodak i3200, i3250,
i3300, 3400 and i3450 Scanners. Any differences between the scanner
models will be noted.

Image processing refers to features of the scanner that allow you to
automatically adjust each image that may improve the resulting images
(i.e., correcting any skew in the fed document, cutting the edges of the
image off to remove unneeded borders or cleaning up extraneous
“noise” on the image).

The ISIS Driver is software that communicates with the scanner. This
driver is created and maintained by EMC Captiva and is provided with
the scanner by Kodak Alaris. This driver can be used to interface with
many scanning applications that support ISIS drivers.

The information in this guide provides descriptions of the features on
the tabs of the ISIS Driver windows. The same features should be
available on the user interface of the scanning application you are
using.
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Starting the SVT 1. Select Start>Programs>Kodak>Document Imaging>SVT
Diagnostics/Scan Diagnostics.

Validation Tool X))
Driver Types:

ThwialM

T MDSH
s

Dirivers:

2. Select ISIS for the Driver Type, the Kodak Scanner i3000 as the
Driver, and click OK. The Scan Validation Tool dialog box will be

displayed.
"\ Sean Validation Tool - KODAK 13450 (ISIS) EEEs
AP INELIDEEGEEE; 1)

NOTE: For a description of the icons on the Scan Validation Tool
dialog box, see the next section entitled, “Scan Validation
Tool dialog box”.

3. Click the Setup icon - . The Setup dialog box will be displayed.

Compressian

Frant Calor: [Fione]

Frant Bitonal:

Fear Color:

Rear Bitanal:
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4. Click ISIS to display the Preset Configurations window.

KODAK 13200 on No M

Freszet Configurationz
x

Prezet Mame

[Defauilt]
Black and ‘hite Perfect Page Document
Colar Perfect Page Document

Color Photnilaih

Dezcription

Default zettings.

Fropertiez

Image. .. ] [ Scanner...

The Preset Configurations window saves custom configuration settings.
Each preset is saved locally as an ISIS Driver Preset file with a name
and optional description. Presets can be loaded or deleted from the
Preset Name list, or imported as an IDP file from another location.
There is no limit to the number of presets that can be created.

The Image and Scanner buttons in the Properties field display tabs
associated with configuring the image and scanner settings. See the
sections entitled, “Image options” and “Scanner options” later in this
guide for detailed information.

Icons: Preset Configurations

= | Save Preset — saves your scanner settings for the specified preset

name.
x Delete Preset — deletes the specified preset name and all

—— associated settings.

52 Import Preset — imports an ISIS Driver Preset (IDP) file.

Help — displays on-line help for the window that is currently

7)
“ displayed.
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Preset Name — displays the available presets.
Description — allows you to add a description of the selected preset.
Properties:

* Image: displays the tabs and options associated with configuring the
image settings.

» Scanner: displays the tabs and options associated with configuring
scanner settings.

OK — closes the window after saving your changes.

Cancel — closes the window without saving any changes.

L eEEEEEE©©EE—©E—©————————————————©————————————©©——©———©————©—————©———©——©————————©——©—————©——————©—————©——©———©——©————©——©©——©©©—©———————]
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Scan Validation Tool
dialog box

The Scan Validation Tool (SVT) is a diagnostic application provided by
Kodak Alaris. The SVT user interface allows access to all the features
of the scanner and is a good way to verify that the scanner is working
properly. The Scan Validation Tool allows you to verify scanner
functionality using the ISIS driver.

Scan Validation Tool - KODAK 3430 (ISIS) (== LA
OGO/ |EaW|aODODDHED® ar

Toolbar buttons

W

Gk Setup — displays the user interface for the selected driver.
W Start Scanning — scans the documents in the input tray.
L P Scan One Page — scans only one page.
1_] Stop Scanning — ends the scan session.
- Change/Open Driver — closes the currently opened driver and

displays the Driver Choice window.

Destination — allows you to select a directory to store scanned
— images and their file names. This option is only available when
Save Images to Files is selected.

I-l"f Delete — deletes the files in the destination folder with the file
name prefix you entered.

o License Key — displays the License Key window.

= No Image Display mode — closes the Image Viewer window
(no images will be displayed).

1 One Image Display mode — displays one image at a time.
Two Image Display mode — displays two images at a time.
13 Four Image Display mode — displays four images at a time.
Eight Image Display mode — displays eight images at a time.

o About — displays the About window.

A-61789/ISIS January 2016



Configuring Image
settings

The main ISIS Driver window provides a set of several tabs for
configuring images. You can select each of these tabs and make any
choices necessary to meet your scanning needs.

NOTE: The Image Mode, Camera, Mode and Toggle Patch selections
are available with all of the Image tabs (i.e., Main, Layout,
Image Processing, etc.).

Properties for KODAK 1
—

I Preset: [Default][2]
Image Mode Adjustments | Background | Image Edge Fill | Blank Image Detection | About
[Norrnal v] Main | Layout | Image Processing | Auto Color Detect | Dropout
Camera: Dotz per inch:
Front Image #1 (200 -]
O Front Image #2 Cropping:
[ Back mage #1 [Fixed Ta Transport ']
O Back Image #2 .
Binarization:
[iThreshalding -]
Mode:
Black and White Threshaold
Grayscale i
Calor
Auto Detect Grayscale
Auto Detect Color
Contrast
U ¢ =
Toggle Patch: -50 50
Off -
1
[ copy | [ ok [ Cancel |[ Hep |[ Defaut

Image mode — select one of the following options:

* Normal — typically, for a document, one image is created for the
front side and another image is created for the back side. Select this
option if you want the front and back side to be individual images.

» Merged — select this option if you want one image that contains both
the front side and back side of the document. Image Merge options
are:

- Front on Top; Front on Bottom; Front on Left or Front on Right.

Camera — the selections in the Camera box list the available sides
(front and back) of an image where you can define individual image
processing values. Options include: Front Image #1, Front Image #2,
Back Image #1 and Back Image #2.

The Kodak Scanner drivers allow you to control the camera settings
independently. Some settings apply only to black and white images,
others apply to color/grayscale images.
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Mode — select one of the following modes:

« Black and White: if you want your electronic image to represent all
elements of your document in black and white.

» Grayscale: if you want your electronic image to have a range of
varying shades of gray from black to white.

» Color: if you want your electronic image to be in color.

» Auto Detect Grayscale: sets auto color detect for grayscale. See
the section entitled, “Auto Color Detect tab” for more information.

» Auto Detect Color: sets auto color detect for color. See the section
entitled, “Auto Color Detect tab” for more information.

Toggle Patch — indicates you want to tell the scanner, via a toggle

patch document, if the document is color/grayscale or black and white.

» Off: no patches will be used.

» Same Side: only the side which recognizes the patch sheet will
toggle.

» Both Sides: a patch will be recognized on either the front or the back
side.
Buttons — the buttons on the bottom of the window apply to all tabs:

» Copy — this function is only available when scanning two-sided
documents. The Copy button provides a convenient way to set up the
color, grayscale or black and white image settings on one side and
transfer them to the other. For example, if you highlight and set up
Front Image #1, you can use the Copy button to duplicate those
settings for Back Image #1.

» OK — saves the values set on all tabs.
» Cancel — closes the window without saving any changes.

» Help — displays on-line help about the options available on the
selected window.

» Default — resets the values on all tabs to the factory defaults.
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Main tab

The Main tab provides the following options.

Properties for KODAK i

Preset: [Defaul][2]

Image Mode | P‘dju_stments | Background | Image Edge Fill | Blank Image Detection | About
[Norrnal v] Main | Layout I Image Processing I Auto Color Detect I Dropout
Camera: Dotz per inch:
Front Image #1 (200 -
O Front Image #2 Cropping:
[ Back image #1 [Fixed To Transport ']
O Back Image #2 L

Binarization:

[iThresholding -]
Mode:
Black and White Threshold
Grayscale 0
Color
Auto Detect Grayscale
Auto Detect Color

Contrast
U o B
Toggle Patch: B0 50
Off -
|
[ coy | [ ok [ camcel |[ Hep ][Ddauh]l

Dots per inch (dpi) or resolution — indicates the scanning resolution,
which largely determines the quality of the scanned image. The greater
the resolution, the better the reproduction. However, scanning at a
higher resolution also increases scanning time and file size.

Select a resolution value from the drop-down list. The default is 200 dpi.
Available resolutions are: 100, 150, 200, 240, 250, 300, 400, 500, 600
and 1200 dpi.

Cropping — allows you to capture a portion of the document being
scanned. All cropping options can be used with color/grayscale and
black and white images. Front and Back cropping are independent,
however, for dual stream scanning, color/grayscale and black and white
cropping must be the same per side. Only one cropping option can be
assigned per image.

» Automatic: dynamically adjusts the cropping window for different
document sizes based on the edges of the image.

» Aggressive: eliminates any residual black border on any image
edges. In order to achieve this, there is a possibility that a small
amount of image data from the edge of the document may be lost.

» Fixed to Transport: (used for batches of same-sized documents)
allows you to define the area to be imaged. Fixed to Transport
cropping is used in conjunction with paper size and page layout and
assumes you are center-feeding your documents. If you are not using
center feeding, you must select the Layout tab to define your scan
area. See the section entitled, “Layout tab” later in this guide.
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* Relative to Document: (zone processing): (used for batches of
same-sized documents) — zone processing is a floating fixed crop
window (the zone) located relative to the upper left corner of a
document. It allows you to select an area on the document to be
delivered in either color/grayscale or black and white format (a
separate window for both black and white and color/grayscale may
be defined). Different parameters may be selected for both the front
and back of the image.

This option may be used in conjunction with Automatic cropping
where a separate color/grayscale or black and white area to be
saved is desired. It is useful in applications where a photograph,
signature, embossment or seal appears in a consistent area for an
application (you may want that small area in color/grayscale and the
rest in black and white). To define a zone, select the Layout tab.

» Photo: the scanner will locate the photograph on the document and
return an image that contains just the photograph. If the scanner
finds more than one photograph on a document, one image is still
returned. If no photo is found, the entire document is returned. The
entire document is used to locate the photograph.

» Photo w/ROI (Region of Interest): this option is the same as Photo
(above) except that only a portion of the document (which is specified
on the Scan Area dialog box) will be used to locate the photograph.

Binarization — these options work on grayscale images and outputs a
black and white electronic image. Their strength lies in the ability to
separate the foreground information from the background information
even when the background color or shading varies, and the foreground
information varies in color quality and darkness. Different types of
documents may be scanned using the same image processing
parameters and results in excellent scanned images.

e iThresholding: allows the scanner to dynamically evaluate each
document to determine the optimal threshold value to produce the
highest quality image. This allows scanning of mixed document sets
with varying quality (i.e., faint text, shaded backgrounds, color
backgrounds) to be scanned using a single setting thus reducing the
need for document sorting. When using iThresholding, only Contrast
can be adjusted.

» Fixed Processing (FP): used for black and white and other high
contrast documents. If Fixed Processing is selected, only Brightness
can be adjusted.

» Adaptive Thresholding (ATP): separates the foreground
information in an image (i.e., text, graphics, lines, etc.) from the
background information (i.e., white or non-white paper background).
When using Adaptive Thresholding, Brightness and Contrast can be
adjusted. Use this option when scanning similar type documents.
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Threshold (Brightness) — this option is available when you select
Fixed Processing or Adaptive Thresholding (ATP). This option
allows you to change the black and white image to be darker or lighter.
The higher the threshold value, the darker the image. Use the slider to
select a value from 0 to 255. The default is 90.

Contrast — adjusts how much of the faint detail you want to see in the
output image. The higher the contrast value, the more faint lines will be
shown in the image. The lower the contrast value, the clearer (or less
detailed) the output image will be. If contrast is set too high, you may
get lines or black areas in your output image that you do not want. If the
contrast is set too low, some letters or lines may not show in the output
image. Select a contrast value from -50 to 50. The default is 50.

10
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Layout tab

The Layout tab provides the following options.

: ——

- - = - S
Properties for KODAK 3200 on None _ =5
Preset: [Defautt)[2]
Image Mode Adjustments | Background I Image Edge Fill I Blank Image Detection I About
Main | Layout | Image Processing I Auto Color Detect I Dropout
[Norrnal v]
Camera: Page Size:
5| Frort Image #1 [Letter -85 511 in -]
O Front Image &2 ] ]
[ Back Image 1 Image Orientation
O Back Image #2 (@) Portrait
() Landscape E
Mode: B "
Automatic —_—
Black and White
Grayscale
Color . .
Auto Detect Grayscale Page Orientation
Auto Detect Color @ Top edgs first
() Bottom edge first
() Left edge first
Toggle Patch: () Right edge first
Off -
[ Scan Area... ]
[ Copy | [ ok [ cancel |[ Hep |[ Defaut |

Page Size — the default page size is set when a scanner is first
selected. You can choose a different page size using the drop-down list.
Page size should be set to the Scanner’s maximum when using the
Automatic, Aggressive or Photo cropping option.

Image Orientation

» Portrait: displays the image orientation in the shape of a
conventional portrait, where height is greater than width.

* Landscape: displays the image orientation in the shape of a
conventional landscape painting, where width is greater than height.

» Automatic: the scanner will analyze the content of each document to
determine how it was fed and will rotate the image to the proper
orientation.

Page Orientation — allows you to select the way you place your
documents in the scanner, Top edge first, Bottom edge first, Left
edge first or Right edge first.

Scan Area — displays the Scan Area dialog box. The Scan Area
options are only available for images when the cropping option is Fixed
to Transport or Relative to Document. See the next section entitled,
“The Scan Area dialog box” for more information.

A-61789/ISIS January 2016

11



Scan Area dialog box

The Scan Area dialog box allows you to define the amount of image
data which is returned to the host.

NOTE: Select the Image Mode (either Normal or Merge) based on the
cropping option selected on the Main tab. If you select Normal,
select the side(s) (i.e., Front Image #1, Front Image #2, Back
Image #1 and/or Back Image #2) to be defined.

If you Select Merge, select the orientation of the merged images
(i.e., Front on Top, Front on Bottom, Front on Left or Front
on Right). The scan areas defined for all camera selections are
independent.

» Select Scan Area on the Layout tab to access the Scan Area dialog
box.

NOTE: The Scan Area dialog box is only available when Fixed to
Transport, Relative to Document or Photo w/ROl is selected
on the Main tab.

x

Page Size:
Letter - 85511 in

— Page Layout
' Paotrait
" Landscape

rea

[v Snap

(8

il

v [0
width: |8 1/2"
Height; 11"

Units:

I Inches

()8 I Cancel |

Page Size — the default paper size is set when a scanner is first
selected. You can choose a different paper size using the drop-down
list.

NOTE: Page Size also appears on the Layout tab. If you make a
change on the Scan Area dialog box, the same selection
appears on the Layout tab and vice versa.

Page Layout

» Portrait: displays the image orientation in the shape of a
conventional portrait, where height is greater than width.

» Landscape: displays the image orientation in the shape of a
conventional landscape painting, where width is greater than height.

12
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Area

* Snap — enable this option to control the dimensions of the preview
area to fixed 0.3175 cm (1/8-inch) increments. This option is not
available in Pixels mode.

» X: the distance from the left end of the scanner to the left-edge of the
scanning area.

* Y: the position from the top end of the document to the top end of the
scanning area.

« Width: the width of the scanning area.
» Height: the height of the scanning area.

Units — select whether you want the area to be defined in Pixels,
Inches or Centimeters.
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Image Processing tab

The Image Processing tab provides the following options.

Properties for KODAK 13200 on None [
Preset: [Default]2]
Image Mode Adjustments I Background | Image Edge Fill I Blank Image Detection I About
[Noma| v] Man | Lsyout | Image Processing | AutoColor Detect | Dropout
Camera; General 0ptions
Frort Image #1 O Halftone Remaval -
O Front Image #2 O invert Image 5
[ Back Image #1 Add Border -
D Back Image #2 D Hale Fill -
Mode: Document Type
Black and White [Text with Graphicz ']
Grayscals
Color Media Type
Auto Detect Grayscale .
Auto Detect Color [F‘Ialn Raper v]
Better
Moize Filker
Toggle Patch: [Lone Fixel -
[of -
Streak Filker
[ on 0
Copy | [ ok |[ camcel |[ Hep |[ Defaut

General Options

» Deskew — automatically straightens a document within 0.3
degrees of the leading edge of the document. Deskew can detect up
to a 45-degree skew and correct up to a 24-degree angle at 200 dpi
or a 10-degree skew angle at 300 dpi. This option is only available
when Automatic is selected.

NOTE: To prevent data loss, the document must have all four
corners within the image path.

» Halftone Removal — enhances images containing dot matrix text
and/or images with shaded or colored backgrounds using halftone
screens and effectively eliminates noise caused by the halftone
screen.

* Invert Image — allows you to select how the black pixels will be
stored in the image. By default the black pixels are stored as black
and the white pixels are stored as white. Turn this option on if you
want the black pixels stored as white and the white pixels stored as
black.

NOTE: You may want to change this option if your application
misinterprets the image data and stores your image in
reverse of what you expect.

» Add Border — allows you to add a fixed amount of border to the left,
right, top and bottom edge of the image. This option is not available
when Aggressive is selected.

L eEEEEEE©©EE—©E—©————————————————©————————————©©——©———©————©—————©———©——©————————©——©—————©——————©—————©——©———©——©————©——©©——©©©—©———————]
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Hole Fill — allows you to fill in the holes that are around the edges of
your document. The types of holes that are filled include: round,
rectangular, and irregularly shaped (e.g., double-punched or those
having a slight tear that could have occurred when the document was
removed from a binder).

Document Type
» Text: when the documents you want to scan contain mostly text.

» Text with Graphics: when the documents you want to scan contain a
mix of text, business graphics (bar graphs, pie charts, etc.) and line
art.

» Text with Photographs: when the documents you want to scan
contain a mix of text and photos.

* Photographs: when the documents you want to scan are comprised
mainly of photos.

Media Type — allows you to select the type of paper you are scanning,
based upon the texture/weight. The options are: Plain Paper, Thin
Paper, Glossy Paper, Card Stock and Magazine.

JPEG (Joint Photographic Editor Group) Quality — if you choose
JPEG compression, select one of the quality options:

* Draft: maximum compression which produces the smallest image
size.

» Good: a fair amount of compression but still produces acceptable
image quality.

» Better: some compression which produces decent image quality.

» Best: minimal compression which produces very good image quality.

» Superior: the least amount of compression which produces the
largest image size.

Noise Filter
« None

» Lone Pixel: reduces random noise by converting a single black pixel
to white when it is completely surrounded by white pixels or by
converting a single white pixel to black when it is completely
surrounded by black pixels.

» Majority Rule: sets each pixel based on its surrounding pixels. The
pixel will become white if the majority of the surrounding pixels are
white and vice versa.

Streak Filter — allows you to configure the scanner to filter vertical
streaks from your images. Streaks are lines which may appear on an
image and are not part of the original document. Streaks may be
caused by contaminants on your documents (e.qg., dirt, dust or frayed
edges) or by not following the recommended cleaning procedures for
your scanner. Adjust the extent at which the streaks are filtered by
moving the slider bar from -2 to 2. The default is 0.
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Auto Color Detect tab The Auto Color Detect tab provides the following options. This option is
only available when Auto Detect Grayscale or Auto Detect Color is

selected.

" = - = - = w W W - B
] Properties for KODAK 13200 on None _ — [
] Preset: [Default][2]

Image Mode | Adjustments I Background I Image Edge Fill | Blank Image Detection | About
[Norrnal v] | Main I Layout I Image Processing | Auto Color Detect H
Camera: Colar Content

Front Image #1 [Custom -

g Front Image #2 Color &mnount Calar Threshold

Back Image #1
47 20
O Back Image #2 r’l = rfl =
1 200 1] 100

Mode:

Black and White Leamn

Grayscale Uze the leam mode to determine the proper -

Color Colar Amount for detecting your color

documents. Set the Color Threshaold value

Auto Detect Color and click the Learn button to begin.

I

Amount Detected: 0
Learn...
-

Threshold Detected: O

[ Copy | [ ok ][ cancel |[ Hep |[ Defaut |

e =

Color Content

* Low: documents requiring only a small amount of color to be saved
as color or grayscale images. Used for capturing documents that are
primarily black text with small logos, or contain small amounts of
highlighted text or small colorful photos.

* Medium: documents require more color, as compared with the Low
option, before they are saved as color or grayscale images.

» High: documents require more color, as compared with the Medium
option, before they will be saved as color or grayscale images. Used
for distinguishing documents containing medium- to large-size
colorful photos from plain black text. Photos with neutral colors may
require adjustments to the Color Threshold or Color Amount values in
order to be captured correctly.
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» Custom: allows you to manually adjust the Color Amount and/or
Color Threshold.

NOTE: When setting Auto Color Detect values, it is suggested that
you start with the Medium option and scan a typical job set. If
too many documents were returned as color/grayscale vs.
black and white, then change to the High option and re-run
the job. If too few documents were returned as color/
grayscale vs. black and white, then change to the Low option
and re-run the job. If none of these options provide the
desired result, select Custom option to manually adjust Color
Amount and/or Color Threshold.

Color Amount: the amount of color that needs to be presentin a
document before it will be saved as either color or grayscale. As the
value of Color Amount increases, more color pixels are required. Valid
values are 1 to 200.

Color Threshold: the color threshold or intensity (i.e., pale blue vs.
dark blue) at which a given color will be included in the color amount
calculation. A higher value indicates that a more intense color is
required. Valid values are 0 to 100.

Learn — allows you to calculate your settings based on representative
color documents scanned. Before selecting Learn, place at least 5
representative color documents in the input elevator. The documents
will be scanned and analyzed to determine the recommended Color
Amount.

NOTE: The Color Amount and Color Threshold sliders will be
updated automatically. If these values do not provide the
desired results with your job set, you may need to manually
adjust the Color Threshold.
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Dropout tab The Dropout tab provides the following option.

Properties for KODAK i3200 on Nane [
i
Preset: [Defaut][2]
Image Mode Adjustments I Background I Image Edge Fill I Blank Image Detection | About |
[Norrnal v] Main | Layout | Image Processing I Auto Color Detect | Dropout
Camera: Colar Dropaut
Front Image #1 Colar:
[ Front Image #2 [None ']

D Back Image #1
O Back Image #2

Mode:

Grayscale

Calor

Auto Detect Grayscale
Auto Detect Color

Toggle Patch:
Off -

[ Copy | [ ok ][ camcel |[ hHep |[ Defaut |

The Dropout tab is used to eliminate a form's background so that only
the entered data is included in the electronic image (i.e., remove the
form’s lines and boxes). For black and white images, these settings
effect the grayscale version of the document which the scanner
analyzes to produce that electronic image.

Color Dropout
* None

» Multiple: drops colors other than dark shades (e.g., black or dark
blue ink).

* Predominant: drops the predominant color.
* Red

* Green

* Blue

Aggressiveness: allows you to adjust the extent at which the colors
are dropped. The values range from -10 to 10. The default is 0.

NOTE: This option is only available when Color is set to Multiple or
Predominant.

L eEEEEEE©©EE—©E—©————————————————©————————————©©——©———©————©—————©———©——©————————©——©—————©——————©—————©——©———©——©————©——©©——©©©—©———————]
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Adjustments tab

The Adjustments tab provides the following options.

Properties for KODAK i3200 on None (S
_ —
Preset: [Defaut][2]
E Image Mode Main I Layout | Image Processing | Auto Color Detect | Dropout
Adjustments | Background I Image Edge Fill | Blank Image Detection | About
[Norrnal ']
Camera: Color Adjustment
Sl [Manual ']
O Front Image #2
[ Back Image #1 Brightriess: U 0ok
O Back Image #2 Contrast: r/} 1] £
Mode: Sharper: i =
Black and White
Grayscale Color Balance
Color
Autamatic
Auto Detect Color
0
1]
1]
Cff
[ copy | [ ok [ camced |[ Hep || Defaut |

Depending on your scanning mode the following options are available:

» Black and White mode: no options are available.

» Grayscale mode: Color Adjustment and Background Smoothing are
available.

» Color: all options are available.

» Auto Detect Grayscale: Color Adjustment and Background
Smoothing are available.

» Auto Detect Color: all options are available.

Color Adjustment
* (none)
» Automatic: automatically adjusts each image.

* Manual: allows you to set specific values that will be used for all
images:

- Brightness - changes the amount of white in the color or grayscale
image. The values range from -50 to 50.

- Contrast - makes the images sharper or softer. The values range
from -50 to 50.

- Sharpen - increases the contrast of edges within the image. Values
range from O to 3.

A-61789/ISIS January 2016
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Color Balance
* (none)

» Automatic: adjusts the white background of each document to pure
white. This option compensates for the variations that occur between
different weights and brands of paper.

e Automatic - advanced: for advanced users that want to further
adjust the Automatic option.

- Aggressiveness - allows you to adjust the extent of the variation.
Increasing this value can help with documents that have yellowed
due to age. The values range from -2 to 2.

» Manual: allows you to set specific values that will be used for all
images:
- Red - changes the amount of red in the color image. The values
range from -50 to 50.

- Green - changes the amount of green in the color image. The
values range from -50 to 50.

- Blue - changes the amount of blue in the color image. The values
range from -50 to 50.

Background Smoothing — using this option for documents or forms
with a background color will help produce images with a more uniform
background color.

» Background: select one of the following:
- None - no background smoothing will be performed.
- Automatic - smooths up to three background colors.

- Automatic - advanced - for advanced users that want to further
adjust the Automatic option.

« Aggressiveness: allows you to adjust the extent at which the
background(s) are determined. The values range from -10 to 10.
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Background tab The Background tab provides the following options.

Properties for KODAK i3200 on None [
i
Preset: [Defaut][2]
Image Mods Main it | Image Processing I Auto Color Detect I Dropout
Adjustments | Background | Image Edge Fil I Blank Image Detection I About
[Norrnal v]
Camera: Background Smoothing
O Front Image #2
O Back Image #1 Aggressiveness G 0 -
O Back Image #2
10 10
Mode: Foreground Boldness
Grayscale
Caolor .
Agaressiveness: U 0 =
Auto Detect Color =
-10 10
Off
[ oy | [ ok J[ comcel |[ Hep |[ Defauk |

Background Smoothing — using this option for documents or forms
with a background color will help produce images with a more uniform
background color.

Background

* None
» Automatic: smooths up to three background colors.

* Automatic - advanced: for advanced users that want to further
adjust the Automatic option.

- Aggressiveness - allows you to adjust the extent at which the
background(s) are determined. The values range from -10 to 10.

Foreground Boldness — using this option for documents or forms
where you want the foreground (e.g., text, lines, etc.) to be more
prominent.

Foreground
* None
» Automatic: all foreground will be bolder.

« Automatic - advanced: for advanced users that want to further
adjust the Automatic option.

- Aggressiveness - allows you to adjust the extent at which the
foreground is determined. The values range from -10 to 10.
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Image Edge Fill tab This option fills the edges of the final electronic image by covering the
area with the specified color. Image Edge Fill is performed after all other
image processing options have been applied.

i - - = - 5
Properties for KODAK 3200 on None ==
Freset: [Defaut][2)
Image Mode Main | Layout | Image Processing I Auto Color Detect | Dropout
Adjustments I Background | Image Edge Fill | Blank Image Detection I About
[Norrnal v]
Camera: Image Edge Fil
Front Image #1 Fill Color:
O Front Image #2 [Black ‘]
O Back Image #1
Fi tod
O Back Image #2 izl
Left: 0.000n
Mode: Right: 0.00in |
Black and White
Grayscale Top: 0.000n
Color
Auto Detect Grayscale -
Auto Detect Color Battom: 0.00in
Off
[ oy | [ ok || camcel |[ Hep || Defaut
—— ————= s = = = - ——

Fill Color — allows you to select the color to fill the edges with.
* None
* White
» Black

Frame Mode — fills in an equal amount of the selected color from the
Image Edge Fill drop-down list on all sides of the image, or you can
select a value in the Top, Left, Right and/or Bottom area(s) from each
side of the scanned image to be filled.

NOTE: When using Image Edge Fill, be careful not to enter a value too
large as it could fill in image data that you want to keep.
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Blank Page Detection tab Blank Image Detection allows you to configure the scanner to not give
blank images to the scanning application. Select the image size (KB),
below which an image is determined to be blank. Images with sizes less
than the number you select will not be created. If you use this option,
you must specify a blank image size for each image type (Black and
White, Grayscale and Color) you want to delete. If you do not make an
entry in these fields, all images are kept.

- Sl - )
Properties for KODAK 13200 on None [
Preset: [Defautt)[2]

Image Mode Main I Layout I Image Processing I Auto Color Detect | Dropout
INorrnaI v] Adjustments I Background I Image Edae Fill | Blank Image Detection | About
Camera: Blank Image Detection

Frort Image #1 Made

O Front Image #2 ID” v]

O Back Image #1 Black and white

O Back Image #2

1kB

Mode:

Black and White
Grayscale 1KBE I

Grayscale

Calor

Auto Detect Grayscale
Auto Detect Color Color
TKE

Learn Content
off .

Usze the learn mode ta determine Image content Amount.

Leam
Copy | [ ok ][ cance |[ Hep |[ Defauk
Mode

« Off: all images are given to the scanning application.

» Size: images will be considered blank based on the size of the image
that would be given to the scanning application (i.e., after all other
settings have been applied).

» Content: images will be considered blank based on the document
content within the image. Select Black and White, Grayscale or
Color to choose the maximum amount of content that the scanner
will consider to be blank. Any image that has more content than this
value will be considered non-blank and will be given to the scanning
application. The values range from 0 to 100 percent.

Learn Content — allows the scanner to determine the content amount
based on the documents to be scanned. Click Learn to use this
function.

NOTE: Learn mode cannot be applied to both the front and back sides
simultaneously. You must select the side you want to configure.
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About tab

The About tab displays information about your scanner and driver.

{ -~
Properties for KODAK i3200 on None a

= - &Jw

Presst:

Image Mode

[Default][2]

[ Nomal

7

Camera:

O Front Image 52
[ Back Image &1
O Back Image #2

Front Image #1

Mode:

Black and White
Grayscale
Color

Auto Detect Color

Auto Detect Grayscale

Main I Layout I Image Processing I Auto Color Detect I Dropout

Adjustments | Background | Image Edge Fill I Blank Image Detection | About

ISIS

CERTIFIED
eki3200 Yersion 1.1.11405.23002
KOD&K, 3400 3200 Series Scanner
Copyright [c] 2014 EMC Corporation
QuickDriver Yersion 2.0.11310.23002

Device Infarmation:

EML, Captiva and I1515 are either registered trademarks ar
trademarks of EMC Corporation in the United States and/or
other countries. QuickDriver iz a trademark of EMC |
Corporation. Al other trademarks uzed herein are the property
of their respective owners.

@ Copyright 201 3 EMC Corparation. All rights reserved.

= ——

Copy | [ ok || cancel |[ Hep || Defau ]IJ
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Configuring Scanner  To access scanner settings from the ISIS Driver, go into the Scan
settings Validation Tool as described earlier in this guide and access the ISIS
driver.

]

"KODAK 13200 on None

Preset Configurations
X

Frezet Mame

[Drefault]
Black and ‘white Perfect Page Document
Color Perfect Page Document

Calar Phnloiraﬁh

Degcription

Default zettings.

Properties

Image. .. ] l Scanner...

Cancel ]

» Click Scanner to configure settings associated with the scanner. The
following sections provide descriptions and procedures for
configuring Scanner settings. See the section entitled, “Configuring
Image settings” earlier in this guide for image configuration
procedures.

1
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Scanner tab The Scanner tab provides the following options.

- .
Properties for KODAK 3200 on None 5

Preset: [Defaut]?]

Scanner | Multifeed Detection I Imprinter I Log | About |

Document Feeder
Paper Source:

ADF

Feeder Position

250 Sheets -

| Awtomatically start transport
Sheet Counter 0
Tirneout
| On
U

1 120 seconds

o
|k

Besponse:

| Stop Scanning - |
Document Handling | Marmal - |
Document Pratection: | Maone - |
b awirnum Length: 17
Power S aver: 15 -
Pawer Off: B0 -
[ ok |[ camcsl |[ Hep || Defaut

Document Feeder

Paper Source

» ADF: the input elevator is in the highest position. This selection is
recommended when you are scanning 25 sheets or less from the
input elevator.

* Flatbed: the scanner will scan from the flatbed.
Feeder Position

* Normal: looks for paper in the document feeder first. If there are no
documents in the input tray, the scanner will scan from the flatbed.

» 100 Sheets — this selection is recommended when you are
scanning between 25 and 100 sheets from the input elevator.

» 250 Sheets — this selection is recommended when you are
scanning between 100 and 250 sheets from the input elevator.

Automatic start transport — if selected, the scanner will wait for up to
10 seconds for documents to be placed in the input elevator before
scanning will begin.

Sheet Counter — enter the number to be assigned to the next physical
sheet of paper entering the scanner. This is incremented sequentially
by the scanner and is returned in the image header.
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Timeout — allows you to select the amount of time, in seconds, the
scanner will wait once the last document enters the feeder before the
timeout occurs. This option can also be turned off.

Response — indicates the action that will be taken when the document
feeder timeout has been reached.

» Stop Scanning: scanning will stop and control will return to the
scanning application (i.e., ends the job).

» Pause Scanning: scanning will stop but the scanning application will
be waiting for additional images (i.e., stops the feeder). Scanning
may be resumed by pressing the Start/Resume button on the
scanner. Scanning may be stopped by pressing the Stop/Pause
button on the scanner or via the scanning application.

Document Handling — allows you to select how the scanner
transports documents through the scanner. This affects how the
documents are fed into the scanner, how fast they move through the
scanner, and how they are placed in the output tray.

* Normal

» Special: for irregularly shaped documents (e.g., pages with coupons
removed or documents with large holes or cutouts in them).

Document Protection — allows you to select how aggressively the
scanner detects documents that enter the scanner incorrectly. This can
occur when documents are not prepared properly for scanning

(e.g., stapled or paper clipped documents).

« None

* Minimum: select this option if the scanner is stopping too frequently
on documents that you do not want it to detect.

NOTE: Documents may become more damaged before detection
occurs.

* Normal: this is the recommended option as it provides a balance
between minimizing document damage and stopping the scanner
unnecessarily.

* Maximum: select this option to get the least amount of document
damage.

NOTE: This may cause the scanner to stop unnecessarily.
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Maximum Length — enter a value that indicates the length of the
longest document in your document set.

NOTES:

* Changing this value will affect the maximums for the following
settings: Area - Width; Height; Printer - Offset From Lead Edge;
Multifeed - Length Detection.

* Not all combinations of settings are supported at the larger lengths
(i.e, resolution, color, grayscale, etc.). To allow for greater flexibility
with applications, the scanner will not generate an error until it sees a
document whose length is not supported.

» The scanner’s throughput may be reduced for larger lengths.

Power Saver — allows you to set the amount of time (0 to 240
minutes) the scanner will remain inactive before the scanner goes into
an idle state. The default is 15 minutes.

Power Off — allows you to set the amount of time (0 to 240 minutes)
the scanner will remain inactive before the scanner will turn the power
off.

L eEEEEEE©©EE—©E—©————————————————©————————————©©——©———©————©—————©———©——©————————©——©—————©——————©—————©——©———©——©————©——©©——©©©—©———————]
28 A-61789/ISIS January 2016




Multifeed Detection tab Multifeed detection aids in document processing by detecting
documents that may go through the feeder overlapped. Multifeed can
happen due to stapled documents, adhesives on documents or
electrostatically charged documents. The Multifeed Detection tab
provides the following options.

Properties for KODAK i3200 on None S

Preset: [Defauit][2]

Scanner | Muttifeed Detection | imprinter | Log About

Fulti-Feed Detection

| Length Detection

Max Length:
11.000n

Auta Set

| Ultrazonic Detection

Sengitivity: Low h
Action:
| Stop Scanning - | 4
Operations
LCalibrate...
[ ok || cancel |[ Hep || Defait |

Length Detection — when you enable Length Detection you can
select the maximum length of the document that can be scanned
without a multifeed being detected. Length detection is used when
scanning same-sized documents to check for overlap. For example, if
you are scanning A4 (8.5 x 11-inch) documents in portrait mode, enter a
value of 28.57 cm (11.25 inches) in the Max Length field. The maximum
value is 35.56 cm (13.99 inches).

* Auto Set: automatically sets the maximum length value to 1.27 cm
(.50-inch) greater than the length of the currently selected page size.

Ultrasonic Detection — check this option to set multifeed detection.

» Sensitivity — controls how aggressively the scanner will work to
determine if more than one document is fed into the transport.
Multifeeds are triggered by detecting air gaps between documents.
This allows multifeed detection to be used with job sets containing
documents with mixed thicknesses.

- Low: the least aggressive setting and is less likely to detect
labels, poor quality, thick or wrinkled documents as multifed
documents.
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- Medium: use Medium sensitivity if your application has varying
document thickness or labels attached to the document.
Depending on the label material, most documents with labels
should not be detected as a multifed document.

- High: the most aggressive setting. This is a good setting to use if
all documents are similar in thickness to 75.2 g/m2 (20-Ib.) Bond
paper.

» Action — select what action you want the scanner to take when a
multifeed is detected. With all options, the condition will be logged in
the scanner.

- Continue Scanning: the scanner will continue to scan.

- Stop Scanning: scanning will stop and control will return to the
scanning application (i.e., ends the job). Verify that the paper path
has been cleared and restart the scan session from the scanning
application.

- Stop Scanning - generate image(s): scanning will stop and
control will return to the scanning application (i.e. ends the job).
Image(s) of the multifed document will be generated. Verify that
the paper path has been cleared and restart the scan session
from the scanning application.

- Pause Scanning: scanning will stop but the scanning application
will be waiting for additional images (i.e., stops the feeder).
Scanning may be resumed by pressing the Start/Resume button
on the scanner. Scanning may be stopped by pressing the Stop/
Pause button on the scanner or via the scanning application.

- Pause Scanning - leave paper in path: scanning will stop
immediately (i.e., making no attempt to clear the paper path) but
the scanning application will be waiting for additional images (i.e.,
stops the feeder). Clear any documents from the paper path prior
to resuming the scan session. Scanning may be resumed by
pressing the Start/Resume button on the scanner. Scanning may
be stopped by pressing the Stop/Pause button on the scanner or
via the scanning application.

- Stop Scanning - leave paper in path: scanning will stop
immediately (i.e., making no attempt to clear the paper path) and
control will return to the scanning application (i.e., ends the job).
Clear any documents from the paper path prior to restarting the
scan session from the scanning application.

Speaker icon — clicking this icon will display the Open dialog box
allowing you to select the desired tone (.wav file) for your alarm.

Calibrate — displays the Calibration window allowing you to perform a
UDDS calibration.

NOTE: Frequent calibration is not necessary or recommended. Only
perform a calibration when instructed to do so by your support
personnel.
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Imprinter tab The printer operates at full scanner speed. The printer can add a date,
time, document sequential counter, and custom messages.

The print string can be configured to include both literal (static)
information (i.e., information that stays the same for each document,
such as batch name or operator) and dynamic information (i.e.,
information that may change for each page scanned, such as the
document sequential counter). The capture software application
controls static fields; any information that the software allows you to
enter can be sent to the printer.

r .
Properties for KODAK i2200 on None [

Preset: [Defautt)[2]

| Scanner | Multfeed Detection | Imprinter | Log | About |

Digital Stamp
Mode: Alignment:
Frant Side -] [Lett ~
Format Template: Top Margin:
W 025

Date Unitz:

Format: Delimiter: Inches -

MMDDYY Y ~| [None v Font

MNarmal -

Counter Rotation

Field ‘wfidth: g = 90 Degrees ~
Farmat:

Digplay Leading Zeros - | H

Example:

[ ok )| cancel |[ Hep |[ Defauit |

(S A

Digital Stamp: Mode — to enable this option, select Front Side.

Alignment — select where you want the print string to be placed.
Options are: Left, Center, Right.

Format Template — the format template is used to build the print
string. The print string is what is printed on documents as they travel
through the transport. The print string is printed before the document is
scanned, therefore, it is part of the image. The maximum amount of
characters for each print string is 40 characters (including spaces).
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Date — if you want to add a date to the print string, select one of the
following formats:

* Format: MMDDYYYY, DDMMYYYY, YYYYMMDD, YYYYDDD or
DDD.

» Delimiter: select one of the following separators: slash: /,
dash: -, dot: ., space or none. For example: 08/24/2010,
08-24-2010, 08.24.2010 or 08 24 2010 or 08242010 (none).

Counter — if you want to add a Counter to the print string, you can
enter one of the following options:

* Field Width: used to control the width of the document counter.
Values range from 1 to 9.

» Format — allows you to configure the format of the counter when the
width of the value is less than the field width (the examples indicate a
field width of 3 and the counter at 4). Options are:

- Display Leading Zeros (default): “004”
- Suppress Leading Zeros: “4”
- Compress Leading Zeros: “ 4"

Top Margin — allows you to define the distance from the lead edge
before the print string begins. Enter the desired amount in the text box.

NOTE: Printing automatically stops 6.3 mm (1/4-inch) from the trailing
edge of the document even if the information has not been
completely printed.

Units — select Inches, Centimeters or Pixels.

Font — you can select what orientation you want your information to be
printed. Available character styles: Normal, Large and Bold.

e e T
3 A w
. ™ ™

Normal: 90° rotation Large: 90° rotation Bold: 90° rotation

Rotation — you can select either 0 or 90 degrees.

Example — shows a sample of what the print string will look like. As
you select items on the Imprinter tab, the corresponding portion within
the example will be highlighted.
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Log tab The Log tab provides a listing of any errors that have been

encountered.
["Broperties for KODAK 13200 on None [
Preset: [Defaul][2]

| Scanner I Multifeed Detection | Imprinterl Log |About |

ECDAE 13200 on Hone

[ ok ][ cancel |[ Hep |[ Defauit |

You can view the Operator and Meter logs and save this information to
a file by clicking the Save icon, or copy the information to the clipboard
by clicking the Copy icon, which can then be pasted into a document.
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